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1 .  INTRODUCCIÓN  

1.1 - RESUMEN 

a gestión de espacios naturales en países en vías de desarrollo requiere hoy día 

el uso de herramientas modernas para la obtención rápida y eficiente de  

información de apoyo. En este sentido, la modelización hidrológica y del 

comportamiento erosivo de cuencas frente a las escorrentías generadas por la  

precipitación pluvial reviste especial interés. En este proyecto, se llevará a cabo una 

recopilación bibliográfica de las variables medioambientales  determinantes del 

comportamiento hidrológico del terreno, así como de datos geográficos de acceso libre, 

aspecto este último fundamental en estos países.  El tratamiento de la información se 

realizará en el entorno de un Sistema de Información Geográfica en el cual se 

implementarán modelos hidrológicos  especialmente validados a nivel de cuenca 

(USLE, SWAT, etc.) 

ABSTRACT: 

Today the management of natural areas in developing countries requires, the use of modern 

tools for quick and efficient information support. In this sense, the hydrologic modeling and 

erosion behavior of river basins in front of the runoff generated by the precipitation is of special 

interest. In this project, we will conduct a bibliographic collection of the environmental 

variables determining the hydrological behavior of the field, as well as geo-free access, data 

which is crucial in these countries. The treatment of the information will be held in the 

environment of a Geographic Information System which will implement hidrologic models 

especially validated at the basin level (USLE, SWAT, etc.) 

 

L 
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1.2 - OBJETIVOS DEL PROYECTO Y MOTIVACIÓN DEL 

TRABAJO 

l principal objetivo de este trabajo está centrado en la modelización hidrológica 

y comportamiento erosivo de una pequeña cuenca frente a las escorrentías 

generadas por la precipitación pluvial de una zona situada en el corazón del 

país de Angola. Para ello se utilizará las diferentes herramientas de análisis espacial, 

análisis hidrológico, interpolación y georreferenciación de imágenes que nos permite 

desarrollar el software especializado en gestión y análisis de información geográfica 

ArcGIS de ESRI (se ha elegido esta herramienta de trabajo por ser una de las pioneras 

en el sector y con gran potencial para el tratamiento de datos en formato ráster y 

vectorial). El problema que se genera es la dificultad de obtener datos precisos de series 

climáticas referidos a estaciones meteorológicas del terreno para realizar un estudio 

detallado de las escorrentías, lo cual nos lleva a utilizar datos climáticos libres 

obtenidos mediante observaciones de satélite.  

La utilización de las herramientas modernas para gestionar espacios naturales en 

países  de vías de desarrollo es una de las principales motivaciones para realizar este 

trabajo por la importancia y utilidad real que les pueda suponer a los angoleños, los 

cuales están necesitados de nuevos datos cartográficos para ir avanzando en la gestión 

de sus territorios. Además de ello, se le suma la filosofía de utilización de datos libres y 

la posibilidad de adquirir nuevas destrezas en el manejo de herramientas de Sistemas 

de Información Geográfica con ArcGIS. 
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1.3 - ANTECEDENTES Y ARTÍCULOS RELACIONADOS 

omo muchos de los países del continente africano, Angola es uno de ellos en 

los que su situación socioeconómica se encuentra en vías de desarrollo y lejos 

todavía de encontrar una estabilidad, debido principalmente a la guerra civil 

que se desató en el país en 1975 tras independizarse de Portugal y que perduró hasta 

2002. El país posee unos abundantes recursos naturales (principalmente minerales y 

petróleo) y su economía pudo empezar a crecer a partir de 1990 gracias a las 

exportaciones de estas materias primas, pero a pesar de ello, el nivel de vida de la 

mayor parte de los angoleños es muy bajo con grandes desigualdades económicas, 

pues la mayor parte de la riqueza está en manos de un porcentaje muy pequeño de sus 

habitantes. 

Fue durante este periodo bélico donde además de las pérdidas humanas, se 

destruyeron importantes edificios, patrimonio, y otras datos de interés gubernamental, 

entre ellos la mayoría de las estaciones meteorológicas ocasionando la pérdida de datos 

en las series de precipitación y temperatura in situ desde 1979 a 2003, que a su vez 

coincide con el climate shift de los 70’s, donde se documentaron cambios importantes en 

el clima global. Por ello, fue de gran utilidad el trabajo de diferentes científicos para 

reconstruir series meteorológicas a través de una combinación de los datos que se 

pudieron salvar de las estaciones in situ y los datos obtenidos de diferentes satélites: 

por parte de NCEP1 (Rodriguez Fonseca et al., 2009) y con datos TRMM2 se obtuvieron 

modelos de comportamiento hídrico y representaciones de curvas IDF (Intensidad-

Duración-Frecuencia) para zonas más específicas de Angola, en concreto la zona 

noroeste (Awadallah et al., 2011 & Awadallah et al., 2013). 

Estos artículos y otros, como el “Comparison of satellite rainfall data with observations 

from gauging station networks” (Hugens, 2006) el cual estudia los datos de 

precipitación de estaciones terrestre en combinación con las del satélite GPCP3 para 

cuatro grandes cuencas de regiones africanas, nos servirán para desarrollar la parte del 

estudio hidrológico del presente Trabajo Fin de Grado (en adelante TFG). 

 

                                                      
1 NCEP: National Center for Environmental Prediction, dependiente de la NOAA (National Oceanic 

and Atmosperic Administration) donde se pueden conseguir datos satelitales de diferentes fenómenos 

atmosféricos entre latitudes 50º y -50º  

2 TRMM: Tropical Rainfall Measuring Mision: datos satelitales de precipitación a nivel global entre 40º 

y -40º, dependientes de la NASA (National Aeronautics and Space Administration)  

3 GPCP: Geostationary Satellite Precipitation Data Centre, dependiente de la NASA 

C 
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1.4 - ESTRUCTURA DEL TRABAJO 

l presente TFG presenta un total de 6 capítulos diferenciados incluyendo esta 

primera introducción que incluye el resumen, los antecedentes, y los objetivos 

del trabajo haciendo hincapié en la problemática que tiene la no disponibilidad 

de datos climáticos y la importancia que tiene el reconstruir esos datos con fuentes 

externas para posteriores estudios a realizar. 

En el capítulo 2 se hará un pre análisis de la zona de estudio indicando su localización 

y haciendo un repaso de los datos más relevantes extraídos de la “Carta de Solos do 

Centro de Estudios da Chianga” (Dias Nogueira, 1978) que nos servirán de apoyo para 

los posteriores análisis morfológico e hidrológico. 

En el capítulo 4 se explicarán de forma detallada los diferentes métodos que se han 

empleado para llevar a cabo los objetivos planteados en el capítulo uno, entre ellos está 

la obtención de una micro cuenca para la zona de estudio en concreto con la 

herramienta ArcGIS, un posterior estudio geomorfológico del terreno que finalizará 

con un estudio hídrológico desarrollado  en el capítulo 4. 

En el capítulo 5 se argumentarán los resultados obtenidos, comparándolos con otros 

resultados similares obtenidos en diferentes textos científicos para exponer finalmente 

las conclusiones de dichos resultados. 

Para concluir se hará un listado detallado de todas las fuentes de información que 

hayan sido útiles para el desarrollo del trabajo en el capítulo 6. 
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2 .  PREANÁLISIS  DE LA ZO NA DE 

ESTUDIO 

2.1 - LOCALIZACIÓN 

l estudio se va a desarrollar dentro del área de una zona experimental del 

Instituto de Investigación Agronómica de Angola: el Centro de Estudios de 

Chianga (en adelante CEC) situado a 13 km al noreste de la ciudad de Huambo  

(Angola) cuyas coordenadas geográficas WGS84 son: -12.741535, 15.831289 

(fig.1).  

A groso modo, puede decirse que el CEC está limitado al sur y sudoeste por el rio 

Culimaala, al nordeste por la ribera Calaupanda, al este por la ribera Chianga (ambas 

afluentes de Culimaala), y al norte y nordeste por una línea discontinua cercana a la 

“Reserva Forestal do Caminho de Ferro de Benguela”. Esta información y la restante para 

realizar el pre análisis de la zona se obtuvo de la “Carta do Solos do Centro de Estudios 

da Chianga” (Dias Nogueira, 1978). 

 
Figura 1. Vista Localización Huambo 

E 
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2.2 - GEOMORFOLOGÍA 

hianga constituye una "colina" más o menos redondeada, con relieve liso y 

ondulado con pendientes generalmente pequeñas (entre  el 5 y el 7%). Con 

altitudes comprendidas entre aproximadamente 1650 m y 1740 m (el punto 

más alto), las laderas de la colina son cortadas por varios canales donde hay numerosos 

cursos de agua (ríos y arroyos) que desembocan en el río Culimaala y sirve como límite 

natural para el CEC en el sur y suroeste (fig.2).  

Morfológicamente, Chianga es 

el testimonio residual de una 

actividad volcánica que estalló 

a través de una gran erupción 

de rocas que caracterizan la 

geología de la región. A. 

Gieseck había clasificado esta 

área como unos anillos 

volcánicos y relacionados con 

otros anillos existentes en 

Angola . De hecho, Chianga es 

parte de una serie de 

estructuras de anillo de 

Angola, cuyas primeras 

referencias remontan a 1939, 

cuando E. Pollinard estudió 

esta región. 

Las estructuras principales que se mencionaron son (además de la Canata): Chincca, 

Chiango, Capuia, Bailundo, Sulima, Chauja, Quizia, Chimboa y Longonjo, 

estrechamente vinculadas con las rocas alcalinas y carbonatadas. Estas estructuras 

tienen una alineación de tectónica con orientación SO-NE.  

 

 

 

C 

Figura 2. Localización Centro de Estudios de Chianga  
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2.3 - GEOLOGÍA  

onsultando el esquema geológico de Angola, el CEC se encuentra atrapado en 

el gran estanque de rocas eruptivas antecambricas y sin fecha definida con 

precisión, compuesto de granitos, granodioritos y cuarzo-Diorita. Chianga, sin 

embargo, tiene características geológicas especiales que hacen prácticamente una 

excepción dentro del distrito de Huambo. 

El CEC se sitúa en una zona con mucho interés en el campo de la investigación 

geológica, ya que es una zona que, aunque de tamaño reducido, es litológicamente 

muy variada. Resulta complicado hacer la separación y delimitación de los diferentes 

tipos litológicos, debido a la enorme capa de adulteración de rocas cubriendo la zona, y 

el reducido número de afloramientos rocosos y fenómenos de solifluxión en la cual se 

someten las zonas inclinadas. Este último aspecto puede llevar a encontrar un suelo 

derivado de sienita sobre una roca de granito, es decir en virtud de la tierra de la cuota 

de una reunión de formaciones volcánicas más elevada. 

Con los aspectos mencionados, bajo el punto de vista geológico y consecuentemente 

desde el punto de vista edafológico, pueden considerarse en el CEC dos zonas 

completamente distintas: una zona central que se ha visto afectada por los fenómenos 

volcánicos y cuyos suelos proceden de rocas lávicas, y otra (a cielo descubierto) cuyos 

suelos son francos procedentes de rocas ácidas, eruptivas o cristalofísicas y 

quartzíferas. También hay que señalar, por los aspectos mencionados anteriormente 

que el paso de una zona a otra es bastante difusa, razón por la cual, estos suelos 

deberán ser considerados como "suelos de contacto" y derivados de materiales mixtos. 

Monteiro Marques (Monteiro Marques, 1963) considera en el CEC dos tipos 

fundamentales de rocas: 

a) eruptivas quartzíferas, dando suelos como cuarzo 

b) eruptivas no quartzíferas. 

Las primeras comprenden los granitos y rocas afines, y las segundas, el sienito 

nefelínico y rocas piroclásticas (brecha, y toba volcánico). 

En la carta de suelos (fig.3) se puede observar la ubicación de los afloramientos rocosos 

que se encuentran en la cartografía de los suelos y la delimitación de la zona que, 

desde el punto de vista edafológico, fue influenciada por los fenómenos volcánicos y 

por las orillas del río Cuilmaala. 

C 
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Figura 3. Mapa Geológico Centro de Estudios de Chianga  

  

 

 

 



Juan C. Argente Sanz  Creative-Commons                   2014        

   

2. Preanálisis de la zona de estudio 13 

 

2.4 - CLIMA 

os datos de los elementos climáticos del CEC han sido ampliamente divulgados 

a través del Boletín Mensual de la División de Meteorología Agrícola. Algunas 

ligeras diferencias que puedan encontrarse en los valores ahora representados 

(tabla 1) son resultantes de la actualización de algunos datos. 

Los primeros datos de los elementos meteorológicos datan de 1943, momento en que 

fue creado el Puesto Udométrico de la Chianga. Este pasó en 1953 a la categoría de 

Estación Climatológica, que con la creación de Instituto de Investigación Agronómica 

de Angola, en 1961, fue bastante mejorado y pasó a contar con una batería triple de 

evapotranspirómetros. Posteriormente, se ha enriquecido con el montaje de una 

"estación actinométrica" para la medición de los valores horarios de la radiación global, 

de la radiación difusa y la radiación directa. 

 
Tabla 1. Datos meteorológicos del Centro de Estudios de Chianga 

Para caracterizar el clima según las normas de la Organización Meteorológica Mundial 

(que considera necesario un periodo de observaciones de 30 años), los datos existentes 

no son lo suficientemente representativos. El conocimiento de estos datos y sus 

posteriores análisis son de gran importancia para los técnicos agrarios y agricultores 

L 
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que constantemente se tienen que preocupar por el estudio de las relaciones entre las 

labores y el medio ambiente a lo largo del año agrícola. 

Desde el punto de vista de las clasificaciones clásicas, se puede decir que el clima del 

CEC es templado (seco o lluvioso) tomando en cuenta la temperatura media anual, el 

promedio anual de la humedad relativa, la variación de la amplitud diurna de la 

temperatura y la precipitación. 

2.5 - PRECIPITACIÓN 

esde el punto de vista agrícola, interesa conocer no solo la cantidad anual de 

precipitación, sino también su distribución a lo largo del año, la intensidad y 

el tipo de precipitación. Efectivamente, para las plantas, no es indiferente que 

una determinada precipitación se produzca en los fuertes aguaceros en días 

consecutivos o se distribuya uniformemente por varios días espaciados a lo largo del 

mes. Del mismo modo, no es indiferente que la precipitación se verifique bajo la forma 

de lluvia, granizo, nieve o incluso niebla o rocío. 

La precipitación media anual en el periodo considerado (1943-1965) es de 1381 mm, 

presentando un máximo 1779 mm en 1951 y un mínimo de 1054 mm en 1959. 

En cuanto a la distribución de la precipitación a lo largo del año, podemos considerar 

dos períodos completamente distintos: la "época de lluvias", que abarca los meses de 

Octubre y Abril, durante la cual se produce aproximadamente el 96% del total anual de 

precipitación, y la "época seca", normalmente denominada "Cacimbo", que comprende 

los meses de mayo a Septiembre, en el que prácticamente no llueve. En ésta última 

época se puede considerar como meses de transición (una vez que la precipitación 

ocurrida es del orden de los 25 mm y en los meses de Junio, Julio y Agosto, rara vez 

llueve). Para la agricultura, sin embargo no tiene la misma importancia la lluvia caída 

en el mes de mayo que la de septiembre. Lo mismo ocurre con la precipitación de 

septiembre que encuentra el suelo completamente sin reservas de agua en las capas de 

superficies, y claramente insuficientes para iniciar un nuevo año agrícola. 

Durante la estación de las lluvias, en la que generalmente se verifican dos máximos, 

uno en diciembre y otro en marzo, es normal la ocurrencia de una pequeña estación 

seca, comúnmente denominada "pequeño Cacimbo", por presentar algunas 

características del Cacimbo propiamente dicho: la ausencia o la cantidad reducida de 

D 
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precipitación, gran disminución de la humedad relativa, el cielo limpio o con pocas 

nubes, aumento de la temperatura y un mayor déficit de saturación. 

El inicio del "pequeño Cacimbo" se da generalmente entre los días 28 de Noviembre y 

el 17 de Febrero, ocurriendo antaño con más frecuencia en los meses de enero y 

febrero; su duración, en media de 13 días, puede prolongarse por más de 30 días. En 

algunos casos se ha comprobado que es otro período de "pequeño cacimbo" (no se 

consideraron los periodos inferiores a 7 días), en cada uno de los cuales la precipitación 

total nunca alcanzó los 10 mm. Normalmente esta precipitación es bastante reducida, 

lo que para algunos cultivos anuales, con sistema radicular superficial, puede ser 

altamente comprometedor. 

2.6 - BALANCE HÍDRICO 

onocidos los valores de la precipitación y la evapotranspiración potencial 

medida, es posible elaborar el balance hídrico o hidrológico, determinando así 

la evapotranspiración real y los meses en que hay exceso, alteración o 

deficiencia de agua en el suelo, teniendo en cuenta la capacidad utilizable. 

Se presenta en la tabla 2 el balance hídrico para el CEC tomando en cuenta los valores 

medios de la precipitación en el período 1943-1965 y los valores medios de la 

evapotranspiración potencial medida desde Noviembre de 1962 a septiembre de 1968. 

 
Tabla 2. Balance Hídrico del Centro de estudios de Chianga 

  

C 
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En la figura 4 se encuentra la representación gráfica del balance hídrico. Por su 

observación se comprueba que hay exceso de agua en los meses de Diciembre, Enero, 

Febrero, Marzo y Abril y la deficiencia de agua en los meses de Junio, Julio, Agosto, 

Septiembre y Octubre. En el mes de mayo hubo cadencia del agua almacenada en el 

suelo y en el mes de noviembre y principios de diciembre hubo reposición de agua en 

el suelo, hasta completar el valor de su capacidad de campo, a partir del cual comenzó 

a existir exceso de agua en el suelo. 

 
Figura 4. Balance Hídrico CEC 
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2.7 - VEGETACIÓN 

a vegetación del CEC se encuentra bastante modificada por la acción del 

hombre que, dada la necesidad de uso de la tierra, va procediendo a su caída, y 

a través de los incendios, a su degradación. La división de la tierra va 

procediendo a su deterioro, y el cuerpo de Investigación Agronómica de Angola ha 

tomado algunas medidas en el sentido de evitar daños mayores e incluso se reservó 

una zona razonable de vegetación natural, menos afectada por el hombre - Reserva 

florística - en el que se estudió detalladamente la composición florística y en donde se 

propone observar su evolución a lo largo de los años. 

Brito Teixeira y Cardoso de Matos (Dias Nogueria, 1978) elaboraron la carta de 

vegetación del CEC (fig. 5), incluiyendo las siguientes formas: "bosque abierto", 

"sabana arbolada", "sabanas con arbustos" y a veces "estepas con árboles y/o arbustos". 

En algunos casos, y esto también se verifica en algunas manchas de vegetación del 

CEC, la sabana arbolada es establecida artificialmente por eliminación de algunos 

árboles y especies de la sabana bosque, con el fin de aumentar la superficie del estrato 

herbáceo para el pastoreo.  

 

L 
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Figura 5. Usos del suelo CEC 
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2.8 - TERMINOLOGÍA UTILIZADA EN LA CARACTERIZACIÓN 

MORFOLÓGICA DE LOS SUELOS  

e presenta brevemente la terminología referente a la “textura” , “consistencia” y 

“porosidad visible” utilizada para hacer la descripción morfológica de los 

diferentes perfiles y de las series correspondientes en el artículo de morfología 

de las cuencas hidrológicas (Ibañez Asensio et al., 2011):  

Textura:  

Las designaciones utilizadas son las correspondientes a las clases de textura adoptadas 

en el Departamento de Agricultura de los Estados Unidos (USDA) (fig. 6):  

- Arena    (sand) 

- Arena-arcillosa   (loamy sand) 

- Limo arenoso   (sandy loam) 

- Marga    (loam) 

- Marga-arcillo-arenoso  (sandy clay loam) 

- Arcillo-arenoso   (sandy clay) 

- Marga-arcilloso   (clay loam) 

- Limoso    (silt) 

- Marga-limoso   (silt marga) 

- Marga-arcillo-limoso  (silty clay loam) 

- Arcilloso-limoso   (silty clay)  

- Arcillosos    (clay) 

 

 

 

 

 

 

 

 

S 

Figura 6. Tipos de suelo 
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Sand -> [2 - 0.05] mm 

Silt ->    [0.05 – 0.002] mm 

Clay ->  [ < 0.002] mm 

 

 

Consistencia: 

Expresando la mayor o menor dificultad al desmenuzamiento de la tierra entre los 

dedos (en el estado seco y en el estado húmedo), se utilizaron los siguientes términos:  

Consistencia en estado seco:  

- Suelta (loose) 

- Ligéramente dura (slightly hard) 

- Dura (hard) 

- Muy dura (very hard)  

- Extremadamente dura (extremely hard).  

Consistencia en estado húmedo: 

- Suelto (loose) 

- Muy quebradizo (very friable) 

- Quebradizo (friable) 

- Firme (firm) 

- Muy firme (very firm) 

- Extremadamente firme (extremely firm).  

Porosidad visible:  

Se refiere a la existencia de orificios o poros visibles a simple vista o con la ayuda de 

una lupa. Se utilizan las siguientes designaciones: "cerrado", "poco poroso", 

"medianamente poroso", "bastante poroso" y "muy poroso". Como norma se refieren 

también a las dimensiones de los "poros", con las siguientes designaciones:  

Ordinario - > 5 mm   Finos - 1-2 mm  

Medios - 2-5 mm   Muy finos - <1 mm  

 

Figura 7. Comparación gráfica de arena, limo y 

arcilla 
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2.9 - CLASIFICACIÓN DE LOS SUELOS 

egún “A preliminary Atlas and profile of Huambo” (Development Workshop 

Angola, 2012) dos son los tipos de suelos dominantes en Huambo: ferralsosles en 

las elevaciones más altas y fluvisol aluvial en la parte inferior, más húmedos, 

principalmente a lo largo de las líneas de agua. Estas designaciones pertenecen al 

sistema de clasificación de suelo de la Organización de Alimentación y Agricultura 

(FAO). 

· FERRALSOLES: son de color rojo y amarillo cuyos colores son el resultado de una 

acumulación de óxidos de metales, especialmente el hierro y el aluminio (a partir de la 

cual el nombre de la tierra del grupo se deriva). Están formados geológicamente sobre 

capas de materiales antiguos en climas tropicales húmedos. Debido a los residuos de 

los óxidos de metal y la lixiviación de nutrientes minerales, son de baja fertilidad y 

requieren de la adición de cal y fertilizantes, en caso de ser utilizadas para la 

agricultura. Su principal uso agrícola es el pasto y también son a menudo el cultivo de 

aceite de palma, caucho, o el café. 

Los ferrálsoles son técnicamente definidos por una textura de capa fina arcilloso-

limoso, de alto contenido de kaolinitic de barro y de hierro y óxidos de aluminio, y 

cantidades bajas de iones decalcio o de magnesio. Están relacionados con otros suelos 

de la clasificación originarios de climas tropicales y con alto contenido en hierrocomo 

Plinthosols y Alisols. 

Los ferralsoles son derivados de la meteorización de las rocas subyacentes, así como de 

sedimentos antiguos depositados en el terreno por acción del viento y del agua. Éstos 

dominan el área de la superficie de Huambo, pero son poco productivos para la 

agricultura, debido a que los suelos son permeables y por tanto tienen una baja 

capacidad de retención de agua. Esta permeabilidad en combinación con la alta 

precipitación conduce a la lixiviación, con la consiguiente pérdida rápida de nutrientes 

minerales y materia orgánica.  

A pesar de los bajos contenidos de nutrientes de agua, el potencial de los ferrálsoles 

para la producción de cultivos es limitado, con rendimientos moderados, que puede 

lograrse con el uso adecuado de los fertilizantes, estiércol y otras medidas para 

incrementar la materia orgánica y el contenido de minerales del suelo. En ausencia de 

este tipo de medidas para gestionar el suelo, los rendimientos de maíz en los ferrálsoles 

en Huambo por lo general varían entre 100 y 400 kilogramos por hectárea.  

S 
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· FLUVISOLES ALUVIALES: Se encuentran normalmente en posiciones topográficas 

que se inundan periódicamente por aguas superficiales o aumento de aguas 

subterráneas, como en los ríos de las llanuras aluviales y deltas y en las tierras bajas 

costeras. Estos se utilizan para el pastoreo en la estación seca y se definen por un débil 

o inexistente horizonte superficial (capa superior) y por materiales derivados de ríos, 

lagos, o sedimentos marinos. Estos suelos presentan una estratificación del perfil que 

refleja su deposición capas irregulares orgánicas y minerales en los que el contenido de 

carbono orgánico disminuye con la profundidad. Se observan grandes variaciones en 

su textura y composición mineral.  

Los suelos aluviales que se encuentran a lo largo de los ríos son más productivos 

debido a su mayor contenido de materia orgánica y humedad. Por lo tanto, tienen una 

gran capacidad para retener el agua y los agricultores utilizan diversas técnicas de 

riego para controlar los niveles de agua durante la lluvia y la temporada seca. Sin 

embargo, algunos de los parches de suelos aluviales están mal drenados y por lo tanto, 

son demasiado húmedos para la agricultura. Los rendimientos de maíz en suelos 

aluviales puede llegar a los 1.000 kilogramos por hectárea, una cifra considerablemente 

más alta que en los ferralsoles.  

Consultando la “Carta Geral dos Solos de Angola – Distrito do Huambo” (Misión de 

pedología de Angola, 1961), se verifica que los suelos del área del CEC fueron 

clasificados como “Suelos Ferrálicos Típicos Rojos”, derivados de rocas lávicas. La 

descripción general de estos suelos, corresponde sensiblemente a los suelos de la serie 

320 (tabla 3) representados en el trabajo de la “Carta do solos del Centro de Estudios da 

Chianga” (Dias Nogueira, 1978)  como “suelos rojos, de textura fina y profundos”.  

Viendo el análisis de perfil típico de la serie 320 (perfil 53/62) podremos observar la 

composición de cada tipo de partícula según su tamaño (arena, limo, arcilla) 

distribuida según la profundidad del suelo. Haciendo una comparativa con la tabla de 

los suelos podemos generalizar que el suelo del CEC es arcilloso-arenoso que a efectos 

de cálculo del coeficiente de escorrentía lo catalogaremos como mayoritariamente 

arcilloso.  

 
Tabla 3. Serie 320 perfiles típicos 



Juan C. Argente Sanz  Creative-Commons                   2014        

   

3. ANÁLISIS de la cuenca 23 

 

 

3 .  ANÁLISIS  DE LA CUENCA  

3.1 - DELIMITACIÓN DE LA CUENCA 

ara calcular los parámetros de la cuenca que nos permitirán realizar un estudio 

hidrológico y geomorfológico de la zona de estudio haremos uso de la 

herramienta ArcGIS y de sus componentes ArcCatalog (para gestionar los 

datos), ArcMap (utilización de herramientas y visualización y 2D) y ArcScene 

(visualización 3D). Este proceso se desarrollará de una forma estructurada siguiendo 

los siguientes pasos: 

1) Adquisición de datos: El principal 

conjunto de datos con el cual vamos a 

trabajar es el modelo digital de 

elevaciones (DEM) obtenido a través del 

servidor Aster GDEM 4 mediante el cual, 

partiendo de las coordenadas conocidas 

de CEC, podremos adquirir el archivo 

TIFF5 donde se refleje la información de 

la elevación del terreno con una 

extensión de unos 100 km2 (fig. 8).  

 

 

                                                      
4 http://gdem.ersdac.jspacesystems.or.jp/index.jsp : Plataforma creada por la NASA de distribución 

gratuita de MDT del 99% de la superficie terrestre a partir de pares estereoscópicos ASTER con una 

resolución espacial de 30 m 
5Tagged Image File Format: Formato de archivo informático para imágenes  

P 

Figura 8. Aster GDEM 13ºS;15ºE 

http://gdem.ersdac.jspacesystems.or.jp/index.jsp
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Otra referencia necesaria para calcular la cuenca será una imagen de satélite donde se 

refleje con el mayor detalle posible la zona del CEC. Esta se puede obtener 

directamente a través de Google Earth ya que son libres, están corregidas y a una 

resolución razonable para el estudio que se quiere realizar (resolución espacial de 10 

m). A esta imagen hay que añadirle cuatro marcas desde Google Earth en los extremos 

(SI, SD, II, ID) salvando sus coordenadas para realizar después la georreferenciación en 

ArcMap (fig. 9). 

 
Figura 9. Imagen satélite CNES / Astrium 23/04/2013 

2) Reproyección del DEM y eliminación de imperfecciones: Para poder trabajar con 

unidades métricas es necesario designarle una proyección al raster DEM. En este caso 

se harán dos reproyecciones6: una con la proyección WGS84 para cuando se trate de 

trabajar con grados decimales y otra UTM correspondiente a la zona 33 sur para 

trabajar con metros. Una vez definida la proyección usaremos la herramienta Fill7, que 

permite rellenar vacíos en la superficie del ráster para quitar imperfecciones en la 

información del DEM. 

3) Dirección de la red hídrica: Por medio de la herramienta Flow Direction8, crea un 

ráster con la dirección de flujo de cada una de sus celdas hasta su vecina con la 

pendiente descendente más pronunciada, aquí seleccionamos el ráster generado 

anteriormente con la herramienta Fill. La salida de la herramienta Dirección del flujo es 

un ráster entero cuyos valores varían de 1 a 255, donde dirección de centro se guiarán 

según la figura 10b 

                                                      
6 Data Management Tools>Projections and Transformations > Raster > Project Raster 
7 Spatial Analyst Tools > Hydrology > Fill 
8 Spatial Analyst Tools > Hydrology > Flow Direction 
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4) Acumulación de flujo: Con la herramienta Flow Accumulation9 (fig. 11), se crea un 

ráster del flujo acumulado para cada una de sus celdas, determinado por la 

acumulación del peso de todas las celdas que fluyen hacia cada celda de pendiente 

descendente. La entrada de esta herramienta es el archivo ráster generado con la 

herramienta Flow Direction, y El resultado de Acumulación de flujo es un ráster de 

flujo acumulado para cada celda, determinado por la acumulación del peso de todas 

las celdas que fluyen hacia cada celda de pendiente descendente. 

   

 

                                                      
9 Spatial Analyst Tools > Hydrology > Flow Accumulation 

Figura 10. a) Proceso dirección de flujo, b)Dirección de centro 

Figura 12. Proceso acumulación de flujo 

Figura 11. Imagen raster dirección de flujo (izq) y acumulación de flujo (dcha)  
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5) Red hídrica: Ahora vamos a construir automáticamente la red hídrica por medio de 

un condicional (esto depende del tamaño del ráster) en “Input true raster or constant 

value” colocar la unidad 1 (fig. 13), señalar directorio de salida, ahora es muy 

importante en “Expression” usar la expresión “value > 400”, este valor depende del 

tamaño del pixel y del ráster, (mientras más grande sea la microcuenca se debe usar un 

valor mayor), como la cuenca debe ser menor de 1000 ha será suficiente con 400. Esto 

se puede llevar a cabo  con la herramienta Con10 (Conditional), el cual permite clasificar 

las celdas con acumulación de flujo superior a un umbral especificado por el usuario, 

por ejemplo al ingresar un valor bajo como resultado mostrará afluentes pequeños de 

la red de drenaje, pero mientras más alto sea el valor se obtendrá la red de drenaje de 

mayor tamaño. 

Como siguiente paso generar un vector entre el resultado de los rásters de la 

acumulación de flujo y el condicional  con ayuda de la herramienta Stream to Feature11 

(fig. 13). 

 

 6) Delimitación de la cuenca: Para poder delimitar la cuenca debemos crear primero 

un punto de desagüe que será el punto final donde drenen las aguas contenidas en la 

cuenca. Esto se puede hacer creando un shapefile tipo punto e interpolando 

posteriormente con el DEM para obtener las coordenadas en tres dimensiones12. Con la 

herramienta Watershed13 obtendremos la delimitación de la cuenca en formato raster 

indicando como archivo de entrada la dirección de flujo, y como punto de desagüe el 

calculado anteriormente. Para convertirlo en formato vectorial se utiliza la herramienta 

                                                      
10 Spatial Analyst > Conditional > Con 
11 Spatial Analyst > Hydrology > Stream to Feature 
12 3D Analyst Tools > Functional Surface > Interpolate Shape 
13 Spatial Analyst Tools > Hydrology > Watershed 

Figura 13. Imagen vectorial acumulación de flujo  
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de conversión Raster to Polygon14 (en el caso de que no se haya trabajado con el DEM 

en la proyección UTM, habría que reproyectar este último para obtener las unidades 

métricas). 

 
Figura 14. Delimitación de la cuenca 

 

 

 

 

 

 

 

 

 

                                                      
14 Conversion Tools > From Raster > Raster to Polygon 
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3.2 - GEORREFERENCIACIÓN 

ediante la georreferenciación podremos representar cualquier objeto 

espacial (formato raster) en un sistema de coordenadas y un datum 

determinado,  es por ello que se convierte en un aspecto central para los 

modelados de datos realizados por los SIG. Cuando se realiza una georreferenciación 

de datos ráster, ArcGIS define su ubicación mediante coordenadas de mapa y asigna el 

sistema de coordenadas del marco de datos. La georreferenciación de datos ráster 

permite visualizarlos, consultarlos y analizarlos con otros datos geográficos. A través 

de la barra de herramientas de Georreferenciación de ArcGIS es posible georreferenciar 

datasets ráster, capas ráster (que pueden tener funciones ráster e imágenes procedentes 

de servidores. 

 

 

La imagen obtenida en Google Earth (fig. 9) será la que posicionaremos con la 

proyección que se haya definido para trabajar el estudio de la cuenca (UTM 33S). Como 

tienen diferente proyección, habrá que realizar el geoprocesamiento en WGS84 y 

después reproyectarlo para definir la imagen en coordenadas UTM 33S. Es necesario 

saber las coordenadas de las cuatro marcas definidas en la captura de la imagen, estas 

son: 

 - SI = 12º42’30.08” S 15º45’54.40”E = (-12.708; 15.765) 

 - SD = 12º42’32.33” S 15º51’16.94”E = (-12.709; 15.855) 

 - II = 12º45’15.18” S 15º45’40”E = (-12.754; 15.761) 

 - ID = 12º45’34.45 S 15º50’42.30” E = (-12.759; 15.845) 

Para referenciar la imagen simplemente iremos añadiendo las 

coordenadas a cada punto de control con la herramienta de 

Georreferenciación haciendo zoom a cada marca para incrementar 

la precisión. El resultado será una imagen corregida de su posición 

original hacia la proyección en la que estemos trabajando (WGS84) 

y transformando dicha proyección a la UTM33S obtendremos la 

imagen en formato métrico UTM (fig. 17): 

Haciendo uso de la misma herramienta podremos superponer el mapa de vegetación 

(fig. 18) pero esta vez, en lugar de utilizar coordenadas conocidas se utilizarán 

elementos representativos que sean identificables en ambas imágenes (cruce de 

carreteras, edificio conocido, confluencia de arroyos, etc.). Es importante seguir un 

orden en sentido dextrógiro para tratar de evitar posibles errores en la 

georreferenciación de la imagen.  

M 

Figura 15. Herramienta Georreferenciación ArcGis  

Figura 16. Detalle 

punto de control 
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Figura 17. Imagen georreferenciada con cuenca delimitada  

 
Figura 18. Imagen usos del suelo georreferenciada 
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3.3 - CLASIFICACIÓN DE LA VEGETACIÓN 

rcMAP posee varias herramientas 15  que permiten obtener clasificaciones 

automáticas (supervisadas y no supervisadas) de una zona determinada pero  

necesitaríamos una imagen satélite de mayor resolución espacial para poder 

determinar una clasificación certera. Otra opción para conseguir una eficaz 

clasificación podría ser recurrir a software especializados en teledetección como es 

ENVI y realizar la clasificación a través de imágenes multiespectrales. A la vista de la 

dificultad para obtener imágenes multiespectrales de buena calidad y los pobres 

resultados obtenidos con una clasificación automática con ArcGIs, es conveniente optar 

por realizar una clasificación manual ya que se trata de una extensión relativamente 

pequeña con pocas clasificaciones a determinar. 

Es de gran utilidad el hecho de poseer un análisis cartográfico previo sobre la 

vegetación de la zona. Con ello, si lo georreferenciamos correctamente podremos 

obtener una clasificación de los usos del suelo editando clases manualmente, 

diferenciando cuatro clases dentro de la cuenca (cultivos, vegetación en rio, sabana y 

suelo urbano [CEC]) representadas en la figura 19. Para ello debemos crear una nueva 

entidad de tipo polígono para cada clase e ir delimitando los límites para completar su 

área (con la ayuda del geoprocesamiento CLIP fijaremos el límite de cada clase con el 

perímetro de la cuenca) 

 

 

 

 

 

 

                                                      
15 Spatial Analyst tool > Multivariate 

A 

Figura 19. Capa clasificación usos del suelo  
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3.4 - PARÁMETROS MORFOMÉTRICOS DE LA CUENCA 

na cuenca está formada por un entramado de ríos, arroyos y/o barrancos de 

mayor o menor entidad que conducen los flujos de agua hacia un cauce 

principal, que es el que normalmente da su nombre a la cuenca; su perímetro 

es una línea curvada y ondulada que recorre la divisoria de aguas entre las cuencas 

adyacentes. El agua que se mueve por toda la superficie o el subsuelo de una cuenca 

hidrográfica hasta llegar a formar la red de canales constituye el sistema fluvial o red 

de drenaje de la cuenca. 

Puesto que existe una estrecha relación entre el caudal del río y diversos factores 

morfológicos como son la anchura y la profundidad de los canales de drenaje, la 

pendiente, el tamaño o la forma de la cuenca, es fundamental llevar a cabo una correcta 

caracterización de las cuencas hidrográficas si queremos optimizar la planificación y 

manejo de los recursos naturales. 

Para poder llevar a cabo este estudio necesitaremos hacer un análisis de las 

características morfométricas más representativas de la cuenca, las cuales podremos 

obtener directamente con herramientas de ArcGIS o apoyándonos de una hoja de 

cálculo para realizar cálculos externos.  

Las propiedades superficiales serán: el área, perímetro, cota máxima y mínima, curva 

hipsométrica, frecuencia de altitudes, altitud media y pendiente promedio; y de 

carácter hídrico serán la longitud del curso principal, el orden de la red hídrica, 

sumatorio de las longitudes de cada orden de la red hídrica, longitud total de la red 

hídrica, y pendiente promedio. A partir de estos datos podremos obtener otros como el 

tiempo de concentración para estimar la escorrentía de la cuenca, pendiente del cauce 

principal, etc. 

Necesitaremos 4 archivos base delimitados por la región de la cuenca para desarrollar 

estos parámetros, los cuales serán: DEM, TIN, Dirección de Flujo y Acumulación de 

flujo. 

· DEM cuenca: Aplicamos una extracción por máscara del DEM original16 reproyectado 

a través del archivo vectorial de la cuenca. Esta misma herramienta la utilizaremos 

para obtener la Dirección de Flujo y la Acumulación de Flujo. 

                                                      
16 Spatial Analisys > Extraction > Extraction by Mask.  

U 
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· TIN cuenca: A partir del archivo generado anteriormente creamos un modelo TIN17 

(Red Irregular de Triángulos): 

 

 

 

 

 

 

 

 

 

 

3.4.1 - Parámetros generales de carácter superficial  

· Área y perímetro: El área de la cuenca está definida por el espacio delimitado por la 

curva del perímetro (P). Se puede obtener directamente desde la tabla de atributos del 

shapefile de la cuenca. Ahí añadiremos un nuevo campo llamado área y calcularemos 

su geometría de tipo doble y como unidades las Hectáreas: El resultado es 681.8938 Ha. 

Del mismo modo se creará un nuevo campo para calcular el perímetro obteniendo un 

resultado de 15437.57 metros. 

· Cotas: Observando el valor del DEM extraído en la cuenca comprobamos el rango de 

los valores máximo y mínimo, siendo Zmax = 1751 m y Zmin = 1610 m lo cual 

corresponde a un desnivel de 141 metros entre el punto más elevado de la cuenca y el 

punto de desfogue. 

                                                      
17 3D Spatial Analisys > Conversion > From Raster > Raster to TIN 

Figura 20. Recorte cuenca: DEM (a), TIN (b), Dirección de flujo (c), Acumulación de flujo (d)  

a b 

c d 
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· Centroides: Otro modo de obtener las cotas máximas y mínimas de la cuenca es 

creando una nueva entidad polígono a partir de la herramienta Raster Domain18 

indicando el DEM de la cuenca como archivo raster de entrada.  

Luego en la tabla de atributos, de igual modo que se hizo para calcular el área, 

podremos obtener nuevas propiedades superficiales teniendo en cuenta los valores de 

elevación (perímetro 3D, Zmax, Zmin, y los centroides de X, Y, y Z): 

 - Perímetro 3D: 18735.57 m 

 - Centroide X: 589194.82 m 

 - Centroide Y: 8592883.4 m 

 - Centroide Z: 1676.86 m 

· Altitudes: Seguidamente se calcularán 

las alturas más características 

(altura media, altura más frecuente 

y altura de frecuencia media). Para 

ello se requiere conocer las 

diferentes áreas entre curvas de 

nivel las cuales se puede obtener 

reclasificando19 el DEM raster de 

la cuenca  con intervalos iguales. 

La altura media, H, es la elevación 

promedia referida al nivel de la estación de 

aforo de la boca de la cuenca. 

La variación altitudinal de una cuenca 

hidrográfica incide directamente sobre su distribución térmica y por lo tanto en la 

existencia de microclimas y hábitats muy característicos de acuerdo a las condiciones 

locales reinantes. Constituye un criterio de la variación territorial la escorrentía 

resultante de una región, la cual, da una base para caracterizar zonas climatológicas y 

ecológicas de ella.  

Una vez obtenidas las diferentes secciones de curvas de nivel podremos calcular sus 

respectivas áreas con la herramienta Zonal Statics as Table 20  (tabla 4). Esto nos 

permitirá diseñar una tabla que relacione los valores obtenidos de las alturas con los 

                                                      
18 3D Analyst tools > Conversion > From Raster > Raster Domain  
19 Spatial Analyst tool > Reclass > Reclassify 
20 Spatial Analyst Tool > Zonal > Zonal Statistics as table 

Figura 21. Intervalo de cotas 
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valores de las áreas (área acumulada, porcentaje de área acumulada, Porcentaje de área 

entre curvas21)[tabla 5]: 

 
Tabla 4. Cruce estadístico área & altitudes  

 

Nº 

Cota Area (Ha) 

Minima Máximo Promedio 

Area 

entre 

curvas 

acumulado % acumulado 

% Area 

entre 

curvas 

1 1610 1633 1627,607 59,11258 685,482205 100 8,62 

2 1634 1657 1647,404 250,9954 626,369625 91,37 36,61 

3 1658 1680 1667,094 234,5856 375,374225 54,76 34,22 

4 1681 1704 1691,122 100,6965 140,788625 20,53 14,68 

5 1705 1727 1714,284 35,8032 40,092125 5,84 5,22 

6 1728 1751 1731,87 4,288925 4,288925 0,62 0,62 

Tabla 5. Cuadro relación altitudes & Areas  

La altitud más frecuente corresponderá con la cota promedio correspondiente con el 

mayor valor de “% Área entre curvas” y la altitud de frecuencia media se puede 

obtener como un pronóstico del 50% entre los valores de la columna “promedio” y los 

valores de la columna “% Área entre curvas”. Con estos valores se puede dibujar un 

gráfico previo para indicar la proporción de superficie con relación a la altitud, 

denominado curva hipsométrica (fig. 22): 

 - Altitud media = 1676.8631 

 - Altitud más frecuente = 1647.404 

 - Altitud frecuencia media = 1675.86 

                                                      
21 Area entre curvas = [Area entre curvas * (% acumulado)] / acumulado  
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Figura 22. Curva hipsométrica de la cuenca 

· Mapa de pendientes: Otra posibilidad que nos permite ArcMap es la de obtener 

automáticamente un mapa de pendientes a través del DEM raster de la cuenca 

utilizando la herramienta Slope22: Seguidamente podremos hacer una reclasificación 

según los intervalos de pendientes que nos interese, en este caso los dividiremos en 

intervalos de porcentaje de 10 en 10 (fig. 23).  

 

 

 

 

 

 

 

 

Realizando una consulta de las estadísticas de este último archivo junto con el DEM de 

la cuenca (tabla 6) obtendremos el número de repeticiones de cada intervalo que nos 

servirá para completar la Tabla 7 y así obtener la pendiente media. La pendiente 

promedio se obtendrá mediante una media ponderada: 

                                                      
22 Spatial Analyst tool > Surface > Slope. 

Figura 23. Mapa de pendientes 
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PENDIENTE 
NÚMERO 

RANGO DE PENDIENTES NUMERO DE 
OCURRENCIAS INFERIOR SUPERIOR PROMEDIO(1) 

1 0 10 5 2904 
2 10 20 15 3147 
3 20 30 25 1005 
4 30 40 35 244 
5 40 50 45 37 
6 50 60 55 11 
7 60 70 65 0 
8 70 80 75 1 
9 80 90 85 1 

10 90 10 95 2 
Tabla 7. Cuadro pendientes 

Pendiente promedio = 
∑                          

∑               
 = 13.331 % 

 

3.4.2 - Parámetros de la red hídrica:  

La morfología de los canales fluviales naturales depende de la interacción entre el flujo 

y los materiales erosionables en el límite del canal. Por su parte, el flujo de agua está 

sometido a dos fuerzas principales: la gravedad y la pendiente del canal, mientras que 

la fricción se opone al movimiento del agua. En atención a ello, el movimiento del agua 

se puede producir el régimen laminar o en régimen turbulento: 

• En el régimen laminar, el agua fluye a velocidades muy pequeñas, de forma que en el 

contacto con el lecho la velocidad del agua es prácticamente nula y las capas superiores 

se deslizan entre sí. 

• En el régimen turbulento, el agua fluye a velocidades mayores, de forma que se 

originan numerosos movimientos caóticos, con remolinos secundarios que se 

superponen al flujo normal, por lo que la capacidad erosiva del flujo es mayor. 

Tabla 6. Cruce estadístico DEM & Pendientes  
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· Longitud del curso principal: La longitud L de la cuenca viene definida por la longitud 

de su cauce principal, siendo la distancia equivalente que recorre el río entre el punto 

de desagüe aguas abajo y el punto situado a mayor distancia topográfica aguas arriba. 

Al igual que la superficie, este parámetro 

influye enormemente en la generación 

de escorrentía y por ello es 

determinante para el cálculo de 

la mayoría de los índices 

morfométricos. Directamente con 

la herramienta Flow Leght 23 

introducimos como dato de 

partida la Dirección de Flujo 

ráster (importante que esta 

esté definida en la proyección 

UTM para poder ver el resultado en 

metros) y como dirección de medida 

DOWNSTREAM que calcula la longitud de flujo aguas 

abajo que consiste en la distancia que una gota de agua 

viajaría para alcanzar el punto de cierre de la cuenca. 

Como resultado obtenemos distancias desde los puntos más alejados hasta la salida de 

la cuenca. En este caso la distancia más larga es de 4713 m, que sería la longitud del 

cauce principal de la cuenca. 

· Orden de la red hídrica: haciendo uso de la calculadora raster calcularemos el log10 de 

la acumulación de flujo, y a ese mismo archivo hay que darle una condicional mayor o 

igual a 2 cuyo resultado será un archivo raster de toda la red hídrica. Ahora bien, para 

diferenciar el orden de la red hay que utilizar la herramienta Stream Order 

introduciendo como raster de entrada el calculado anteriormente y la dirección de flujo 

de la cuenca. El archivo resultante mostrará en diferentes colores cada nivel del orden 

de la red. Para ordenarlo de una manera adecuada hay que convertirlo en formato 

shapefile (cambiando las propiedades se pueden obtener los atributos que indican el 

orden de cada una de las redes) (fig. 26). 

Estos pasos se pueden implementar de manera esquemática utilizando la herramienta 

modelbuilder de ArcGIS24 (fig. 25): 

 

                                                      
23 Spatial Analyst Tool > Hidrology > Flow Length 
24 Geoprocesing > ModelBuilder 

Figura 24. Longitud de flujo      
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· Densidad de drenaje: Se calcula dividiendo la longitud total de las corrientes de la 

cuenca por el área total que las contiene: 

Dónde:  Dd=  ⁄  =2,475 

L: Σ longitud de las corrientes efímeras, intermitentes y contínuas de la 

cuenca en km. 

A: superficie de la cuenca en km2 

Este índice permite tener un mejor conocimiento de la complejidad y desarrollo del 

sistema de drenaje de la cuenca. En general, una mayor densidad de escurrimientos 

indica mayor estructuración de la red fluvial, o bien que existe mayor potencial de 

erosión. La densidad de drenaje varía inversamente con la extensión de la cuenca. 

· Longitud de cada orden: En la tabla de atributos del último shapefile creado (red_order) 

añadimos un nuevo campo llamado longitud, en el cual calcularemos su geometría de 

propiedad Length. Basta con hacerle una consulta al campo de grid_code del tipo 

sumatorio para que nos calcule la longitud total de cada orden de la red hídrica, que 

haciendo un sumatorio nos dara como resultado la longitud total de la red (tabla 8). 

 

 

 

Tabla 8. Longitud de la orden 

Orden de la 

red 
Longitud (m) 

1 10589,86 

2 2432,7 

3 2904,78 

4 949,12 

TOTAL 16876,46 

Figura 25. Modelbuider para calcular la orden de la red hídrica  
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· Pendiente promedio de la red hídrica: Se calcula como media ponderada de las pendientes 

de todas las superficies elementales de la cuenca en las que la línea de máxima 

pendiente se mantiene constante; es un índice de la velocidad media de la escorrentía 

y, por lo tanto, de su poder de arrastre o poder erosivo.  

     
∑    

 
 

J= pendiente media de la cuenca 

Li= Longitud de cada tramo de la red hídrica en las curvas de nivel (km) 

E= Equidistancia de las curvas de nivel (km) 

A= superficie de la cuenca (km2) 

Para este último paso será necesario interpolar el mapa de pendientes con la red_shp 

mediante la herramienta Interpolate Shape 25  y posteriormente hacer un cálculo 

estadístico con “Zonal Statistics as table” (tabla 9) combinando el archivo este último 

creado con el mapa de pendientes. El campo que nos interesa de este cálculo es el de 

MEAN donde se refleja el promedio de las pendientes de cada orden. 

 
Tabla 9. Cruce estadístico pendiente & orden de la red  

                                                      
25 3D Analyst tool > Functional surface > Interpolate shape 

Figura 26. Orden de la red hídrica 
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Orden de la 
red 

Número de 
veces (1) 

Pendiente 
promedio 
(2) 

(1)*(2) 

1 437 1,6247 709,9939 

2 97 1,5979 154,9963 

3 117 1,82051 212,99967 

4 42 2,238 93,996 

Total 693 
 

1171,98587 

Pendiente promedio RH 1,6911 

Tabla 10. Pendiente promedio de la red hídrica 

3.4.3 - Resumen de parámetros morfométricos 

A continuación se agrupa a modo de resumen todos los parámetros morfométricos de 

la cuenca en la siguiente tabla: 

Descripción Valor Unidades 

Superficiales 

Área 681,8938 Ha 

Perímetro 15437,57 m 

Cota máxima 1751 msnm 

Cota mínima 1610 msnm 

Centroide X 589194,8219 m 

Centroide Y 8592883,444 m 

Centroide Z 1676,8631 msnm 

Altitud Media 1676,86 msnm 

Altitud más frecuente 1647,404 msnm 

Altitud de frecuencia media 1675,86827 msnm 

Pendiente promedio de la cuenca 13,3310664 % 

De la red Hídrica 

Longitud del curso principal 4713 m 

Densidad de drenaje 2,475  

Orden de la Red Hídrica 4  

Longitud de la red Hídrica 16876,46 m 

Pendiente Promedio de la red Hídrica 1,6911 % 

Tabla 11. Resumen parámetros morfométricos.  
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4 .  ESTUDIO HIDROLÓGICO  

4.1 - TIEMPO DE CONCENTRACIÓN 

l tiempo de concentración es una de las variables más importantes a determinar 

en la planificación de usos del suelo y en la conservación de suelos y aguas o 

gestión de recursos.  

Este se define como el tiempo mínimo necesario para que todos los puntos de una 

cuenca estén aportando agua de escorrentía de forma simultánea al punto de desagüe.  

Está determinado por el tiempo que tarda en llegar a la salida de la cuenca el agua que 

procede del punto hidrológicamente más alejado, y representa el momento a partir del 

cual el caudal de escorrentía es constante, al tiempo que máximo; el punto 

hidrológicamente más alejado es aquél desde el que el agua de escorrentía emplea más 

tiempo en llegar a la salida. 

Para una lluvia de intensidad constante el caudal en la salida irá aumentando a medida 

que vaya llegando el agua de escorrentía procedente de puntos hidrológicamente cada 

vez más alejado, manteniéndose constante a partir del momento en el que el punto más 

alejado ya esté aportando agua a la salida. El tiempo de concentración es un parámetro 

característico de cada cuenca y depende de los siguientes factores:  

- Del tamaño de la cuenca: a mayor tamaño mayor tc. 

- De la topografía: a mayor accidentalidad o pendiente, menor tc. 

- La forma: a igualdad de otros factores, las cuencas alargadas presentan 

menores tc que las cuencas apaisadas o redondeadas. 

 

 

E 
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4.1.1 - Métodos de estima 

La determinación del tiempo de concentración se puede realizar con ayuda de tablas o 

ecuaciones empíricas (Gisbert Blanquer et. al, 2011) , siendo las más utilizadas, en 

cuanto a tablas, las de Agres, la del USDA y la de Comack; en cuanto a las ecuaciones, 

destacan las de Bransby-Williams, Ventura-Heras, Giandotti, Kirpich, Passinni y la 

Dirección General de Carreteras (España). Como la cuenca estudiada tiene un área de  

menos de 1250 Ha podremos obtener el valor del tiempo de concentración como 

promedio de las ecuaciones de la USDA, Giandotti, Kirpich, Bransby-Williams y la de 

la DGC (eliminaremos las que presenten valores extremos y nos quedaremos con el 

promedio de las 3 últimas): 

· Ecuación USDA: 

                 = 6.836 min 

            

  L = Longitud del cauce principal (m) = 4713 m 

  S = Pendiente media del recorrido (m/m) = 0.0169 

· Giandotti: 

    
         

        
          

 A = Área de la cuenca (Km2) = 6.8189 Km2 

 L = Longitud del cauce principal (Km) = 4.713 Km 

 S = Pendiente media del recorrido (m/m) = 0.0169 

· Kirpich: 

                       = 64.824 min = 1.08 horas 

 L = Longitud máxima a la salida (m) = 4713 m 

 S = Pendiente media del lecho (m/m) = 0.0169 
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· Bransby-Williams: 

    
 

     
√
  

 

 

             

 L = distancia máxima a la salida (km) = 4.713 km 

D = diámetro del círculo de área equivalente a la superficie de la cuenca (km2)   

D = 2.946547 km 

M = área de la cuenca (km2) = 6.818938 

F = pendiente media del cauce principal (%) = 1.69 

· Dirección General de Carreteras (DGC): 

      (
 

     
)
    

            

J= pendiente media del cauce principal (H/L) = 0.0169 m/m 

H= diferencia de nivel entre el punto de desagüe y el punto hidrológicamente 

más alejado (m) = 141 m 

L= longitud del cauce principal (km) = 4.713 Km 

Promedio [DGC, Bransby-Williams, Kirpich] = 1.367 horas = 82.028 min 
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4.2 - ESTIMACIÓN DE LAS PRECIPITACIONES MÁXIMAS 

uando se produce una precipitación en una zona, pocas veces es exactamente 

igual a la anterior lluvia precipitada días atrás. Aunque estemos en el mismo 

lugar y no hayan transcurrido muchos días desde entonces la duración de la 

lluvia es diferente, y su intensidad o agresividad también. La variabilidad de la lluvia 

es enorme, tanto espacial como temporalmente, pero el uso y gestión del terreno y de 

todo tipo de recurso (suelo, agua, biomasa, etc…), nos exige un conocimiento previo de 

la precipitación que podemos esperar en una zona.  

El análisis de las series de precipitación de suficiente longitud nos permite disponer de 

información fiable relativa a tres preguntas fundamentales: ¿cuál es la intensidad de 

precipitación máxima que podemos esperar en una zona?, ¿cada cuánto tiempo es 

posible que se produzca un fenómeno de dicha intensidad? , y ¿existe la posibilidad de 

estimar intensidades máximas de tormentas de duración inferior a 24 horas?  

Definir la lluvia característica de una zona es una tarea compleja. Datos como la 

precipitación media anual o la distribución estacional de las lluvias aportan 

información muy valiosa en muchos ámbitos que incluso es válida para clasificar 

climáticamente los territorios, pero que resulta claramente insuficiente cuando 

tratamos de dimensionar una cuenca de pequeño tamaño. En éstas situaciones en las 

que trabajamos con escorrentías lo que necesitamos saber es cómo va a responder el 

suelo frente a la lluvia y si va a ser superada o no su capacidad de infiltración, y esto no 

depende exclusivamente de la cantidad total de agua recibida sino más bien de en 

cuánto tiempo se recibe y cómo se recibe (tamaño de gota, velocidad de caída, etc…) 

(Ibañez Asension S. et al, 2011). 

La relación entre lluvia caída y el tiempo que dura la precipitación es lo que conocemos 

como intensidad de la precipitación (I). La intensidad se mide en mm/h y su valor se 

deduce de las bandas de los pluviógrafos o de los registros de las estaciones 

meteorológicas automáticas. Es un dato muy importante en hidrología puesto que 

junto con la capacidad de infiltración del suelo determina la cantidad de escorrentía 

generada por un aguacero. Considerando despreciable las pérdidas de agua debidas a 

la evaporación y a la transpiración de las plantas, la expresión simplificada del ciclo del 

agua refleja esta relación: 

E = P - I,  siendo E= escorrentía 

P= Precipitación 

I= Infiltración 

C 
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4.2.1 - Relación intensidad-duración-frecuencia 

En estas curvas, sobre el eje de las 

abscisas se representa la duración 

de la tormenta (expresada en 

minutos o en horas) y en el eje de 

las ordenas la intensidad (expresada 

en mm/h). Son características de 

cada lugar en particular, pero en 

todas las regiones climáticas del 

mundo siguen la misma tendencia 

(fig. 27): 

Las curvas Intensdidad–Duración–Frecuencia (IDF) son curvas que resultan de unir los 

puntos representativos de la intensidad media en intervalos de diferente duración y 

correspondientes todos ellos a una misma frecuencia o período de retorno (Temez, 

1978). 

Junto con la definición de las curvas, surgen otros elementos a considerar como son la 

intensidad de precipitación, la frecuencia o la probabilidad de excedencia de un 

determinado evento. Por ello es de suma importancia tener claro el concepto de cada 

una de estas variables para tener una visión más clara de las curvas IDF. 

En este sentido, se debe destacar que la intensidad se define como la tasa temporal de 

precipitación, o sea, la profundidad por unidad de tiempo (mm/h) y esta se expresa 

como: 

 I = P/Td  donde P = Profundidad de lluvia (mm) 

     Td = Duración (hr) 

Es importante señalar que cuando sólo se dispone de un pluviómetro en una estación 

es evidente que en general solo se podrá conocer la intensidad media en 24 horas. Esta 

información puede inducir a errores por defecto ya que las lluvias de corta duración 

son en general las más intensas. 

 

 

 

Figura 27. Modelo curva IDF 



Juan C. Argente Sanz  Creative-Commons                    2014  

46 4. Estudio Hidrológico  

 

4.2.2 - Concepto de intensidad máxima esperada 

Si lo que queremos es estar seguros de que la obra que la cuenca “cumpla 

correctamente su cometido” deberemos tomar aquélla intensidad que genere mayor 

escorrentía. Es decir, que de todas las posibles tormentas nos deberemos fijar 

únicamente en las más extremas, en las más torrenciales, que son las que aportan 

lluvias de intensidad máxima. Las curvas Intensidad-Duración se elaboran por tanto a 

partir de los datos de precipitaciones extremas, por lo que la intensidad 

correspondiente a una duración de tormenta determinada siempre es máxima. 

Ahora bien, aunque la obra de ingeniería funcione correctamente durante algunos años 

es previsible que no siempre sea así, y no podemos estar seguros de que no se 

producirá una precipitación que rebase nuestros cálculos puesto que realmente no 

todos los años llueve de la misma manera y es posible que de vez en cuando ocurra 

una precipitación “anormalmente” elevada comparativamente con lo que 

consideremos como “normal” en un año cualquiera. Se introduce así el concepto de 

frecuencia o periodo de retorno (T). 

 

4.2.3 - Concepto de periodo de retorno (T) 

El concepto de periodo de retorno (T) responde a la idea de que la probabilidad de que 

se produzca una lluvia de determinadas características (en intensidad y duración) 

siempre va asociada a un intervalo de tiempo concreto (la frecuencia o periodo de 

retorno T). Las curvas de Intensidad-Duración-Frecuencia (IDF) son el conjunto de 

curvas que representan para cada periodo de retorno concreto (hay una curva para 

cada T) los valores de las intensidades máximas medias de lluvia esperables en función 

de la duración del aguacero. Como el estudio se centra en una cuenca hidrológica para 

observar el comportamiento de unos cultivos experimentales, consideraremos un 

periodo de retorno de 20 años. 

 

4.2.4 - Curvas de intensidad-duración-frecuencia 

Las curvas Intensidad-Duración-Frecuencia (IDF) son características para cada 

localidad y para obtenerlas se deben considerar todos los episodios de lluvia ocurridos 

en dicho sitio a lo largo de un gran número de años, siendo imprescindible tener 
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registrados los datos correspondientes tanto a la cantidad de lluvia (mm) caída como a 

la duración de las tormentas. 

Debido a los escasos datos climáticos y la dificultad de relacionar los datos TRMM de 

satélite con los de las estacones terrestres (este apartado se deja abierto para posteriores 

trabajos), para el estudio de nuestra cuenca, se obtendrán las curvas IDF de una región 

climática similar a la zona de Huambo: la zona elegida ha sido extraída del artículo 

“Developing Intensity-Duration-Frecuency Curves in Scarce Data Region: An approach 

using regional analysis and Satellite data” (Awadallah et. al, 2011) y hace referencia a 

la base situada en M Baza Congo (con clima tropical húmedo cuya longitud es similar a 

la de Huambo pero su latitud la sitúa en el norte de Angola). 

También se hace necesario evaluar la Intensidad de Precipitación para el tiempo de 

concentración de la cuenca. Si utilizamos un tiempo menor, no permitimos que toda la 

cuenca contribuya al caudal, y si utilizamos un tiempo mayor, la intensidad máxima 

será menor (fig. 28). De este modo con la ayuda de la figura 29 podremos fijar la 

intenesidad máxima para nuestra cuenca que en este caso para un Tc de 82.028 

minutos y un periodo de retorno de 20 años  será de aproximadamente 77 mm/h. 

 
Figura 28. Comparativa tiempo de concentración-curva IDF 

 

 

 

 

 

Figura 29. Curva IDF para la región de "M Banza Congo"  
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4.3 - ESTIMA DE LA ESCORRENTÍA 

xisten diferentes métodos para estimar la escorrentía que se generará en una 

zona a partir de sus datos climáticos, topográficos, edáficos, etc… Se utilizan en 

el ámbito de la ingeniería, tanto civil como agronómica o forestal, siendo 

igualmente muy comunes en conservación de suelos. La mayor parte de ellos son de 

naturaleza empírica, por lo que para que la estima sea realmente fiable es necesario que 

las condiciones de nuestra cuenca sean similares a los supuestos sobre los que se han 

desarrollado y validado los diferentes métodos (Ibañez Asensio S. et al., 2011). 

Desarrollaremos dos métodos empíricos diferentes para obtener la escorrentía: La 

fórmula racional y el método de número de curva. 

 

4.3.1 - Formula racional 

Es un método muy apropiado cuando la información disponible de la zona de trabajo, 

de superficie no superior a 1.000 ha, no es muy exhaustiva; su validez además depende 

de la fiabilidad de los valores del coeficiente de escorrentía (c) y del tiempo de 

concentración empleados en el cálculo. La expresión utilizada para el cálculo toma la 

siguiente forma: 

Q =       ⁄   donde: Q = caudal de escorrentía (m3/s) 

c = coeficiente de escorrentía 

I = intensidad de la precipitación (mm/h) 

A = superficie de la cuenca (ha) 

COEFICIENTE DE ESCORRENTÍA 

Para determinar el coeficiente de escorrentía (c) más acorde con las condiciones de 

relieve, vegetación, etc. de nuestra zona deberemos utilizar alguna tabla o ecuación 

desarrollada al efecto en el artículo de “Metodos para determinar el coeficiente de 

escorrentía” (Ibañez Asensio S. et al., 2011). De entre los diferentes métodos posibles 

(Método de Raws, Molchanov, Prevet, Formula de Nadal y formula de Keler) se 

utilizará la fórmula de Nadal y el método de Prevet porque está diseñado para parcelas 

experimentales teniendo en cuenta el uso de suelo, la pendiente y la textura del suelo 

(tabla 13). 

E 
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Volvemos a ArcMAP para reclasificar18 el mapa de pendientes en nuevos valores (0-

5,5-10,10-30,>30) que combinándolo con el mapa de usos del suelo (fig. 5) obtendremos 

la superficie que ocupa cada  uso en relación a la pendiente. Sabiendo esto y que el tipo 

de suelo es arcilloso obtendremos el valor de “c” mediante Prevet con la ayuda de la 

siguiente tabla (tabla 12): 

 
Tabla 12. Coeficiente de escorrentía Prevet  

 

Prevet Pendiente Carcilloso Area Area*C 

Vegetación 

0-5 0,4 345825 138330 

05-010 0,5 398025 199012,5 

010-30 0,6 189900 113940 

30-44 0,63 
 

0 

Sabana 

0-5 0,45 1434375 645468,8 

05-010 0,55 1505025 827763,8 

010-30 0,65 526050 341932,5 

30-44 0,68 
 

0 

Cultivos 

0-5 0,6 915300 549180 

05-010 0,7 961200 672840 

010-30 0,8 344025 275220 

30-44 0,84 2925 2457 

  
TOTAL 6622650 3766145 

Tabla 13. Valores del coef. escorrentía para cada uso de la cuenca 

Ctotal = (Area*c)total/Areatotal = 0.568676 
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Para la fórmula de Nadal nos fijamos en los diferentes factores que influyen en su 

cálculo (extensión, lluvia y pendiente) y calculamos el coeficiente de escorrentía según 

la fórmula:  

 

 

 

 

c = 0.25*k1*k2*k3 = 0.585 

cpromedio = 0.5768, cuyo resultado en la escorrentía nos dará: 

Q =                   
   ⁄ = 84,126 m3/s 

4.3.2 - Método del número de curva 

El método del número de curva, que proporciona el volumen de la escorrentía total 

(L³), utiliza como primer dato de entrada la escorrentía precipitada (I) en la zona, 

asumiendo por tanto que en una misma cuenca diferentes lluvias provocarán 

diferentes escorrentías. Lo más conveniente será considerar para la estima aquella 

lluvia que genere mayor escorrentía, de ahí que debamos utilizar el tiempo de 

concentración (tc) como punto de entrada en las curvas IDF (Intensidad-Duración-

Frecuencia) de nuestra zona. Conocida la cantidad de lluvia precipitada la escorrentía 

generada puede obtenerse mediante la expresión matemática siguiente: 

Q = 
       

        
⁄  donde: Q = Caudal de la escorrentía (mm) 

      I = Cantidad de lluvia (mm) 

      S = (25400/N)-254 

      N = Numero de curva 

El valor del nº de curva N de entrada en la ecuación se obtiene mediante tablas (tabla 

15) cuyas condiciones del terreno contempladas son:  

Tabla 14. Factores fórmula de Nadal 
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- Uso de la tierra: Cultivos alineados, cultivos no alineados, prados, pastizales, 

prados permanentes, bosques, caseríos. 

- Medidas de conservación empleadas en el cultivo: Dado un determinado uso 

de la tierra, la realización o no de prácticas de conservación normalmente es 

determinante en el volumen de escorrentía generado por la lluvia. Las posibles 

medidas agronómicas destinadas a la corrección de la erosión hídrica son 

inexistencia (R), curvas de nivel (c), y aterrazamientos (C-T). 

- Condiciones hidrológicas para la infiltración: Se diferenciarán entre muy 

pobres, pobres, regulares, buenas y muy buenas. 

- Grupo hidrológico del suelo: Se diferenciarán 4 clases de permeabilidad en 

atención a su profundidad y su textura: 

· Grupo A: Incluye los suelos que presentan mayor permeabilidad 

(arenosos, arenosos-limosos). 

· Grupo B: Incluye los suelos de moderada permeabilidad cuando están 

saturados comprendiendo los terrenos arenosos menos profundos que 

los del grupo A. 

· Grupo C: Incluye los suelos que ofrecen poca permeabilidad cuando 

están saturados, por presentar un estrato impermeable que dificulta la 

infiltración o porque su textura es franco-arcillosa o arcillosa. 

· Grupo D: Es el que ofrece mayor escorrentía por ser menos permeables 

tales como los terrenos muy arcillosos profundo con alto grado de 

tumefacción. 

Con estos matices se puede obtener una escorrentía diferente para cada uso del suelo 

teniendo en cuenta la superficie de cada uso para al final obtener la escorrentía final 

como suma ponderada de cada uso del suelo. Trazada en la tabla 16. 
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Tabla 15. Cuadro relación número de curva 

 

Uso del 

suelo 

Área 

(Ha) 
Clase 

Lab

ore

o 

Condicio

nes para 

la 

infiltració

n 

Grupo 

hidroló

gico 

Numero 

de curva 
S 

Escorrentía Q 

(mm) 

Veget. 93,375 Forestal - Pobre C 78 71,6 32,70954 

Sabana 346,545 Pastizal - Buenas C 74 89,2 69,40621 

Cultivos 222,345 Cultivo R Buenas C 85 44,8 1,417241 

CEC 19,6288 Caserío - - C 82 55,8 9,794768 

TOTAL 681,893       40,49605 
Tabla 16. Cálculo de la escorrentía (número de curva) 
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5 .  CONCLUSIONES  

ediante la realización de este proyecto se ha podido establecer los 

parámetros hídricos y geomorfológicos de una pequeña cuenca hidrológica 

cercana al Centro de Estudios Agronómicos de Chianga, obteniéndose 

parámetros útiles para el estudio de los cultivos experimentales allí situados. A su vez, 

se deja abierta la puerta a profundizar sobre este estudio para obtener otros parámetros 

hidrológicos como la ecuación universal de pérdidas del suelo (USLE) que no se han 

podido desarrollar por carecer de datos experimentales de campo. 

Personalmente ha sido de gran utilidad el hecho de poder trabajar con datos climáticos 

libres (TRMM) para poder dar apoyo a zonas que carecen de dicha información y el 

hecho de trabajar con el software ArcGIS me ha servido para poder descubrir nuevas 

herramientas (análisis espacial, análisis 3D, interpolación, hidrología, etc.) y ampliar 

mis conocimientos en la gestión de usos del suelo con dicho software. 

A su vez, este tipo de proyectos se adapta a la estructura y requerimientos de proyectos 

de Cooperación al Desarrollo para países con necesidad de progreso económico y 

social como lo es Angola. 

 

 

 

 

 

M 
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